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BDwbfvwm©wU Ae †Møvevj wf‡jR (BDwRwf), ewikvj-G 
Ô`ÿZv wfwËK D”P wkÿv c×wZi cÖeZ©bÕ 

 

wewfbœ M‡elYvi wb‡`©kbv †gvZv‡eK evsjv‡`‡ki D”P wkÿv c×wZ‡Z cwieZ©b GLb AZxe Riæwi| eZ©gv‡b GB 
e¨e ’̄v cy‡ivcywiB ZvwË¡K wbf©i †hLv‡b wkÿv_x©‡`i eB Ges †bvU gyL Í̄ K‡i †hb‡Zbfv‡e mb` MÖnYB g~L¨ D‡Ï‡k¨ 
cwiYZ n‡q‡Q| A_P D”P wkÿv c×wZ nIqv DwPZ Ávb, M‡elYv I `ÿZv wfwËK| GB c×wZ n‡e 
mvgvwRK/cwi‡ekMZ cÖ‡qvRb ev ev¯Íe Pvwn`vi wecix‡Z ev Í̄e wfwËK cÖKí ev¯Íevq‡bi Rb¨ Ávb AR©‡bi 
wbqvgK| D”P wkÿv GKRb wkÿv_x©‡K m„wókxj Ges iv‡óªi Pvwn`vi wecix‡Z `ÿ K‡i M‡o Zzj‡e| wKš‘ GLv‡b 
jÿ¨Yxq †h, evsjv‡`‡k D”P wkÿv ax‡i ax‡i m¤ú~Y©fv‡e mb`vq‡bi w`‡K Szu‡K c‡o‡Q| D”P wkÿvi cÖ‡qvRbxqZv 
m¤ú‡K© GKRb wkÿv_x©‡K gva¨wgK I D”P gva¨wgK ¯Í‡iB Ávb AR©b Kiv `iKvi |  
evsjv‡`k wecyj RbmsL¨vi †QvÆ GKwU †`k| GLv‡b 18-25 eQi eq‡mi wZb †KvwU hyeK-hyeZx hv‡`i g‡a¨ 40 
jÿ¨ A‡bK ¯ĉœ Ges m¤¢vebv wb‡q D”P wkÿv MÖnY K‡i| G‡`i AwaKvskB RvZxq wek¦we`¨vj‡qi gva¨‡g cÖZ¨všÍ 
MÖvgvÂ‡j e‡mB wewfbœ K‡j‡Ri gva¨‡g D”P wkÿvi mb` AR©b K‡i †hLv‡b wkÿv c×wZ evsjv nIqvq Ges `ÿ 
wkÿ‡Ki msL¨v AcÖZzj nIqvq  wkÿv_x©‡`i g‡a¨ `ÿZvi Afve †_‡K hvq| wkÿv_x©‡`i AvšÍR©vwZK fvlvi `ÿZv 
bv _vKvq †`wk Ges AvšÍR©vwZK evRv‡i cÖ‡e‡ki c_ †Lvjv _v‡K bv| †h D”P wkÿv GKRb wkÿv_x©‡K Zvi iv‡óª, 
mgv‡R, cwiev‡i wKsev wb‡Ri Dbœq‡b †Kvb f‚wgKv ivL‡Z †`q bv, †m D”P wkÿv ïaygvÎ mb`vqb Qvov Avi wK 
n‡Z cv‡i?  
BDwbfvwm©wU Ae †Møvevj wf‡jR (BDwRwf) ewikvj eZ©gvb D”P wkÿv c×wZ‡K `ÿZv wfwËK D”P wkÿv c×wZ‡Z 
cÖeZ©‡bi j‡ÿ¨ `xN©w`b hver M‡elYv I wewfbœ IqvK©mc/‡mwgbv‡ii gva¨‡g Competency Based 
Education, Training & Assessment (CBET&A) c×wZi D™¢veb K‡i‡Q| G c×wZ cÖeZ©‡bi j‡ÿ¨ 
AvÛviMÖRy‡qU †j‡f‡ji wkÿv_x©‡`i Rb¨ BwZg‡a¨B Competency Based Standard ‰Zwi Kiv n‡q‡Q| 
CBET&A c×wZ‡Z GKRb wkÿv_x© cÖ‡Z¨K †mwg÷v‡i GKwU Level Gi Skill test/Assessment cÖwµqvq 
AskMÖnY Ki‡e| GKwU Level G Kw¤ú‡U›U nIqvi ci cieZx© Level Gi Assessment G AskMÖnY Ki‡Z 
cvi‡e| cÖwZwU Level Gi skill Standard ỳBfv‡e wef³ Kiv n‡q‡Q t Technical Skill (TS) Ges 
Communication Skill (CS)| GB Assessment cÖwµqvi Competent = Pass (A+) Ges Not 
Competent = Fail (0) c×wZ AbymiY Kiv n‡e| BDwbfvwm©wU Ae †Møvevj wf‡j‡R CBET&A c×wZ 
ev¯Íevq‡bi Rb¨ Skill Standard Institute (SSI) cÖwZôv Kiv n‡q‡Q| SSI AÎ wek¦we`¨vj‡q CBET&A 
c×wZi ev¯Íevqb, Industry’i Pvwn`v †gvZv‡eK wewfbœ Level Gi Skill Standard ‰Zwi Ki‡e| cvkvcwk 
Assessment cÖwµqv I Assessor ‰Zwi Kvh©µg I Skill Standard Abyhvqx Level Gi Skill mg~‡ni 
Learning Material cÖ ‘̄Z I wkÿv_x©‡`i †Uªwbs Gi e¨e ’̄v Ki‡e| 
 
 
 
 
 

 w¯‹j ÷¨vÛvW© BÝwUwUDU, 
 BDwRwf, ewikvj| 

 
 
 



Introducing skill based education system at UGV 
 
Different studies indicate that the present higher education system in Bangladesh needs 
serious reforms. This system is usually based on the theoretical approach using textbooks, 
reference material, course outlines etc. Under this system, a certificate becomes the main 
purpose among the students where to acquire the knowledge, skills and attitudes are being 
neglected. Most of the academic institutions have become factory of certificate only. However, each student in the 
higher education who are the future professional should have the 
knowledge, skills, and attitudes. Therefore, they will be able to recognize and solve problems in social, 
environmental needs and national demands. Higher education will make the 
student creative, skilled and knowledgeable. 
 
Bangladesh is most densely populated country with small area. As per the available 
reports it is estimated that, in Bangladesh, currently about 4 million of the 30 million youth 
between the ages of 18 and 25 are enrolled in higher education with great energy, dreams and 
goals, and potential for productive employment. Most of these enrollments for the higher 
education are in the National University through different colleges in the rural areas where 
the instructions and examinations are in Bangla. Therefore, most of the higher educated 
populations in Bangladesh have lack of communication skills internationally due the lack of 
English. This vast number of higher educated populations can not enter into the national 
and the international job markets because of their lack of international language. 
 
Bangladesh’s vision 2021 gives highest importance to building skilled manpower to accomplish a poverty-free 
middle-income country. But we do not see any long term plan based 
on higher education system. However, the University of Global Village (UGV) has, since 
its inception in 2016, recognized the importance of greater diversity of higher education. 
In supporting this work, it has been recognized that there are many key considerations in 
developing and delivering higher education provision in university. In July, 2019, UGV introduced a new 
Competency Based Education, Training & Assessment (CBET&A) under a 
new institute, known as Skill Standard Institute (SSI), which defines a comprehensive set of 
competency requirements that all graduates are expected to attain. The students entering in 
July, 2019 and thereafter are required to demonstrate technical and communication skills in 
different abilities as well as a comprehensive knowledge base as a requirement for graduation. 
Faculty, known as Assessor, use performance-based methods to determine if students have 
attained competence. 
 
In CBET&A method, a student will participate in an assessment process in every semester 
that we call ”Level’s Skill Test”. After becoming competent at the ”Level”, the student 
will be allowed to participate in the next assessment ”Level”. The skill standard of each 
level is divided into two parts: ”Technical Skill (TS)” and ”Communication Skill (CS)”. 
The assessment process will be ”PASS (=competent)” or FAIL (=not competent). The 
implementation of CBET&A methodology, time to time creation of different skill standard 
”Levels” based on the demand of the industries, Assessment process, Assessor preparation 
and provide training to the students will be under the SSI. 
 
 
 
 Skill Standard Institute 
  UGV, Barishal. 

 
 



Abstract 

Competencies are bundles of the essential knowledge, skills and abilities required to achieve an 

acceptable level of performance, while learning objectives are specific to a course of instruction. 

These terms have been defined as follows in the same recommendation: 

 Knowledge means the outcome of the assimilation of information through learning. Knowledge 

is the body of facts, principles, theories and practices that is related to a field of work or study. 

 A skill means the ability to apply knowledge and use know-how to complete tasks and solve 

problems. In the context of the European Qualifications Framework, skills are described as 

cognitive or practical. 

 Competence means the proven ability to use knowledge, skills and personal, social and/or 

methodological abilities, in work or study situations andin professional and personal 

development. 

Objective 

The main purpose of this training is to train students to fit for the approaching world. The objective of 

the assignment is skill based and job market oriented. The implementation of the training intended to 

standardize the recognition, validation and certification of units of learning outcome, focusing on the 

technical components and academic courses. 

Skills development 

Students are taught to develop their skills in: 

Reading which includes: 

Skimming, scanning, detailed reading, guessing unknown words from context, understanding text 

organization, recognizing argument and counter-argument; distinguishing between main information and 

supporting detail, fact and opinion, hypothesis versus evidence; summarizing and note-taking. 

Writing includes: 

 Essay content and structure (patterns of organization, paragraphing, discussion – 

argument/counter-argument, advantages and disadvantages, topic sentence and supporting ideas, 

coherence and cohesion, punctuation).  

 Functions (generalization, definitions, exemplification, classification, comparison and contrast, 

cause and effect, process and procedure, interpretation of data).  

 Style (passive constructions, avoiding verbosity)  



 Punctuation  

Listening includes: 

 General comprehension (listening for gist, listening for detailed information, evaluating the 

importance of information).  

 Lectures (identifying the topic and main themes, identifying relationships among major ideas, 

comprehending key information).  

Speaking includes: 

 Seminar skills (agreeing and disagreeing, clarifying, questioning, concluding).  

 Presentation skills (introductions and stating the purpose, signposting, highlighting key points, 

summaries, conclusions).  

The students' competence in skills development is measured by their ability to understand and produce 

written and spoken language in an educational context, to perform the following academic tasks: 

 reading and understanding written academic language;  

 writing assignments in an appropriate style for university study;  

 listening to and comprehending spoken language (within the framework of Breakthrough level); 

 Speaking to colleagues and lecturers (within the framework of Breakthrough level).  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Skill Standard Institute (SSI) 
University of Global Village (UGV), Barishal. 

Course Structure for 
Skill Standard Certificate 

Program: Competency Based Education, Training & Assessment (CBET&A) 
ENGS-101 (Level-1) 

 
Part-A (Technical Skills-TS) 

 
 Part-B (Communicative Skills-CS) 

Sl.  
No. 

Unit Code Skill Title Level 
Nominal 
Duration 
(Hours) 

Sl.  
No. 

Unit Code Skill Title Level 
Nominal 
Duration 
(Hours) 

1 ENGS-101TS-1  
Typing Skill: 30 words per 
minute in MS Word(English) 

1 60 hrs 1 ENGS-101CS-1 Greetings ( The art of greeting in 
English, necessary for 
communicating with people) 
 

1 10 hrs  

2 ENGS-101TS-2 Microsoft word Word 1 10 hrs 2 ENGS-101CS-2 How to ask, grant or refuse 
permission in English, necessary 
for communicating with people 

1 10 hrs 

3 ENGS-101TS-3 Microsoft word Power Point 1 10 hrs 3 ENGS-101CS-3 Basic writing ( Basic writing skill 
in English for the elementary 
level learners ) 

1 20 hrs 

4 ENGS-101TS-4 Installing Operating System and 
Utility Software 

1 10 hrs 4 ENGS-101CS-4 Basic Vocabulary ( Basic 
vocabulary for Bengali learners ) 

1 20 hrs 

5 ENGS-101TS-5 Opening email account, file 
attachment, CC, BCC, Google 
Drive, YouTube Channel, 
Converting word file to PDF, PDF 
to word, and usage of team viewer.  

1 20 hrs 5 ENGS-101CS-5 Translation ( Everyday use 
sentences which is required for 
communicating in English) 

1 10 hrs 

6 ENGS-101TS-6 PC Assembling and Disassembling 1 10 hrs 6 ENGS-101CS-6 Dialogue ( Practice dialogue 
session for a better 
communicative session 

1 30 hrs 

7 ENGS-101TS-7 Printer Set up, File sharing through 
local network. 

1 10 hrs 7 ENGS-101CS-7 Listening (Practice listening 
sessions for a better 
communicative competence 
understanding) 

1 20 hrs 

Total Nominal Learning Hours 130 hrs Total Nominal Learning Hours 120 hrs 



 
 

 

 
 

 
 
 
 
 
 
 
 

Part-A 

Technical Skill (TS) 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 



 

Learning objective: 

If students complete this level, they should be able to:

 

ENGS-101 TS-1 MS Word:

Typing Skill: After completing this skill they will be able to type 30 words per minute in English.

 

English typing meaningful 30 words per 
Nominal Duration (Hours) 120 hrs. 
 
Objective: 
As in recent times every paper work is computer oriented and English is an international language as 
well as it is very much important in programming and other tasks, so typing words in English is very
much essential task to cope up with the modern world. If anyone can write 30 meaningful words in a 
minute, s/he can easily complete any task in shortest possible time and it can save his/her time 
effectively. 30 words per minute is a standard time duratio

 
Task: 
Continue Practicing to write a page of meaningful English words around 1 hour every day.

 
Outcome: 

1. Be competent for writing any English words in a standard time duration.

2. Be competent for writing any English words by stenography.

 
Skills/Requi

rement 
Physical Appearance

 
 
 
 

Laptop/ 
Keyboard 

 
 

 

 
 
 
 

 

If students complete this level, they should be able to: 

1 MS Word: 

Typing Skill: After completing this skill they will be able to type 30 words per minute in English.

English typing meaningful 30 words per minute. 
Nominal Duration (Hours) 120 hrs.  

As in recent times every paper work is computer oriented and English is an international language as 
well as it is very much important in programming and other tasks, so typing words in English is very
much essential task to cope up with the modern world. If anyone can write 30 meaningful words in a 
minute, s/he can easily complete any task in shortest possible time and it can save his/her time 
effectively. 30 words per minute is a standard time duration for typing. 

Continue Practicing to write a page of meaningful English words around 1 hour every day.

Be competent for writing any English words in a standard time duration. 

Be competent for writing any English words by stenography. 

Physical Appearance Procedure Useful Links

 

Do not rush when you 
just started learning. 
Speed up only when 
your fingers hit the 
right keys out of habit. 
Take your time when 
typing to avoid 
mistakes. The speed 
will pick up as you 
progress. 
Always scan the text a 
word or two in 
advance. 

 

https://www.learntypi
ng.org/beginner
typing

 
https://www.ratatype.
com/typing

 

Typing Skill: After completing this skill they will be able to type 30 words per minute in English. 

As in recent times every paper work is computer oriented and English is an international language as 
well as it is very much important in programming and other tasks, so typing words in English is very 
much essential task to cope up with the modern world. If anyone can write 30 meaningful words in a 
minute, s/he can easily complete any task in shortest possible time and it can save his/her time 

Continue Practicing to write a page of meaningful English words around 1 hour every day. 

Useful Links 

https://www.learntypi
ng.org/beginner-
typing-lesson-1a 

/www.ratatype.
com/typing-test/test/ 



 

Bangla typing meaningful 30 words per minute.
Nominal Duration (Hours) 120 hrs. 
 
Objective: 
As in recent times every paper work is computer oriented and Bengali is our mother tongue as well as 
it is our official language, so typing words in Bengali is very much essential task to cope up with the 
modern world. If anyone can write 30 meaningful words in a minute, s/he can easily complete any 
task in shortest possible time and it can save his/her time

standard time duration for typing. 
 
Task: 
Continue Practicing to write a page of meaningful Bengali words around 1 hour every day.

 
Outcome: 

1. Be competent for writing any Bengali words in a standard time duration.

2. Be competent for writing any Bengali words by dictation.

 
Skills/Requi

rement 
Physical Appearance

 
 
 
 

Laptop/ 
Keyboard 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

**MS Word** 

 

Bangla typing meaningful 30 words per minute. 
Nominal Duration (Hours) 120 hrs.  

As in recent times every paper work is computer oriented and Bengali is our mother tongue as well as 
is our official language, so typing words in Bengali is very much essential task to cope up with the 

modern world. If anyone can write 30 meaningful words in a minute, s/he can easily complete any 
task in shortest possible time and it can save his/her time effectively. 30 words per minute is a 

Continue Practicing to write a page of meaningful Bengali words around 1 hour every day.

Be competent for writing any Bengali words in a standard time duration. 

competent for writing any Bengali words by dictation. 

Physical Appearance Procedure Useful Links

 

Do not rush when you 
just started learning. 
Speed up only when 
your fingers hit the 
right keys out of habit. 
Take your time when 
typing to avoid 
mistakes. The speed 
will pick up as you 
progress. 
Always scan the text a 
word or two in 
advance. 

 

https://www.learntypi
ng.org/beginner
typing

 
https://www.ratatype.
com/typing

 

As in recent times every paper work is computer oriented and Bengali is our mother tongue as well as 
is our official language, so typing words in Bengali is very much essential task to cope up with the 

modern world. If anyone can write 30 meaningful words in a minute, s/he can easily complete any 
effectively. 30 words per minute is a 

Continue Practicing to write a page of meaningful Bengali words around 1 hour every day. 

Useful Links 

https://www.learntypi
ng.org/beginner-
typing-lesson-1a 

https://www.ratatype.
com/typing-test/test/ 



 
 

 

 
**MS Word** 

 

ENGS-101 TS-2 MS Word: 
 Create new file,  

 file opening, 

 save,  

 save as,  

 Page set up, 

 page numbering,  

 font size,  

 font style,  

 font color,  

 Image Edition,  

 Creating Table,  

 Text box.  

 Spelling Checking,  

 Printing set up,  

 Writing Mathematical Equation 
 Type at least 25 words per minute with EnglishLanguage 
 Perform the equation with logicalexplanation 
 Indicate the names and functions of the Word interfacecomponents. 
 Create, edit, save, and print documents to include documents with lists andtables. 
 Format text and to usestyles. 
 Add a header and footer to adocument. 
 Add a footnote to adocument. 
 Add a graphic to adocument. 
 Use the Spelling and Grammar Checker as well as MicrosoftHelp. 
 Manipulate documents using functions such as find and replace; cut, copy, replace. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 
  



 
 

 

**MS Word** 

 
MS WORD SKILLS: LEVEL 1 

 
1.1 How to Insert Text in MS Word: 

The basic steps to insert text or to create a new document in Word are listed below; 

o Go to the start menu and look for Microsoft Word icon 

o Click the icon to open the Microsoft Word 

o You will see a blinking cursor or insertion point in the text area below the ribbon 

o Now, as you start typing, the words will appear on the screen in the text area 

o To change the location of insertion point press spacebar, Enter or Tab keys 

 
 
 
 
 
 



 
 

 

**MS Word** 

 
1.2 How to Delete Text in MS Word: 

You can easily delete the text in Word including characters, paragraphs or all of the content of your 
document. Word offers you different methods to delete the text; some of the commonly used 
methods are given below; 

o Place the cursor next to the text then press Backspace key 

o Place the cursor to the left of the text then press Delete key 

 

o Select the text and press the Backspace or Delete key 

o Select the text and type over it the new text. 

 

1.3 How to Select Text in MS Word: 

Place the cursor next to the text then left click the mouse and holding it down move it over the text 
then release it. The text will be selected. 

 

 

 



 
 

 

**MS Word** 

Some shortcuts for selecting text are: 

o To select a single word double click within the word 

o To select the entire paragraph triple click within the paragraph 

o To select entire document, in Home tab, in Editing group click Select then choose Select 

All option or press CTRL+A 

o o Shift + Arrow; hold down the shift key then press the arrow key, the word will select the 

text in the direction of the arrow key. There are three arrow keys, so you can select the text 

in three different directions. 

 

1.4 How to Copy and Paste Text in MS Word: 

Word offers different methods to copy and paste text. Some of the popular methods are given 
below; 

Method 1; 

o Select the text you want to copy 

o Select the Home tab and click the Copy command 

o Place the cursor where you want to paste the text 

o Click the Paste command in Home tab 

 

 



 
 

 

**MS Word** 

Method 2; 

o Select the text 

o Place the cursor over the text and right click the mouse 

o A menu will appear; with a left click select the "Copy" option 

o Now, move the cursor to a desired location and right click the mouse 

o A menu will appear; with a left click select the 'Paste" option. 

 

1.5 How to Save the Document in MS Word: 

When you create a document it is important to save the document so that it can be viewed or reused 
later. The basic steps to save a document are listed below; 

o Click the Microsoft Office Button 

o A list of different commands appears 

o Click the 'Save As' command 

o it displays 'Save As' Dialogue Box 

o Save the document to desired location with a desired name 

**MS Word** 



 
 

 

You can also choose 'Save' command from the list to save the document to its current location with 
same title. If you are saving a fresh document it displays 'Save As' dialogue box. 

The shortcut method to save a document is to press "Ctrl+S" keys. It opens the 'Save As' dialogue 
box where you can name you document and save it to a desired location. 

 

1.6 How to Correct Errors in Ms Word: 

 

o When you type text in a document, by default the Word informs you if there is any contextual, 

spelling or grammatical error. Word informs you in different ways for different errors; 

o If there is any contextual error in the document, it will underline the text with blue line. 

o If there is any spelling error in the document, it will underline the text with red line. 

o If there is any grammar error in the document, it will underline the text with green line. 

 

 

 
 

**MS Word** 
 



 
 

 

 

Steps to correct errors: 

o Place the cursor over the text that you want to correct 

o Right click the mouse 

o A list of suggestions appears 

o Choose the correct word with a left click 

 

 

 

 

 

 

 
**MS Word** 

 



 
 

 

 

 

 

1.7 How to Check Word Count in Ms Word: 

When you start typing, the Word automatically counts the number of words and number of pages 
and displays the information on the status bar. If the word count is not available on the status bar, 
you can right click the status bar and select the Word Count option from the menu. Basic steps to 
check the word count are listed below; 

o Open the document 

o Look at left bottom corner of the document 

o You will see the total world count and the number of pages 

 
 

To know the word count of a specific line or paragraph you have to select it then Word will display 
its word count along with the total word count, e.g. 15/40. In this example, the selection has 15 
words out of the total number of words (40). 
 
 

**MS Word** 

 
1.8 How to Change Font Size in MS Word: 



 
 

 

You can easily change the font size of your text in the document. The basic steps to change the 
Font size are listed below; 

o Select the text that you want to modify 

o In Home tab locate the Font group 

o In Font group click the drop-down arrow next to font size box 

o Font size menu appears 

o Select the desired font size with a left click 

o Select the text and click the increase or decrease font size buttons 

 
1.9 How to Change Font Style in MS Word: 

The basic steps to change the font of a text in a document are given below; 

o Select the text you want to modify 

o Select the Home tab and locate the Font group 

o Click the drop-down arrow next to font style box 

o Font style menu appears 

o With a left click select the desired font style 

o If you want to change the font to bold or italic, click the 'B' or 'I' icons on the format bar. 

 

 

 

 

 

**MS Word** 

 



 
 

 

 
 

1.10 How to Format Font Color in MS Word: 

MS Word allows you to change the Font color of your text. If you want to emphasize a particular 
word or phrase, you can change its font color. The basic steps to change the Font color are given 
below; 

o Select the text you want to modify 

o In Home tab locate the Font group 

o Click the drop-down arrow next to Font color button 

o Font color menu appears 

o Select the desired font color with a left click 

o Word will change the Font color of the selected text. 

 

 

 

 

 

 

**MS Word** 

 



 
 

 

 
 

1.11 How to Change Text Case in MS Word: 

You can easily change the text case in your document by following the steps given below; 

o Select the text you want to change 

o In Home tab locate the Font group 

o Click the drop-down arrow in 'Change Case' button 

o It displays text case menu 

o Select the desired case with a left click 

The case menu offers four options; 

Sentence case: It capitalizes the first letter of each sentence. 

Lowercase: It changes the text from uppercase to lowercase. 

Uppercase: It capitalizes all the all letters of your text. 

Capitalize Each Word: It capitalizes the first letter of each word. 

Toggle Case: It allows you to shift between two case views, e.g. to shift between Capitalize Each 
Word and cAPITALIZEeACHwORD . 

 

**MS Word** 

 



 
 

 

 
 

1.12 How to Change Text Alignment in MS Word: 

You can change the text alignment in your document to make it more presentable and readable. 
The basic steps to change the text alignment are given below; 

o Select the content you want to modify 

o In Home tab locate the Paragraph group 

o It has four alignment options ; 

Align Text Left: Aligns the text towards left margin 

Center: Brings the text at centre 

Align Text Right: Aligns the text towards right margin 

Justify: Aligns the text to both left and right margins 

o Select the desired alignment option with a left click 

 

 

 

**MS Word** 

 



 
 

 

 
 
 

 
1.13 How to Insert a Text Box in MS Word: 

Text box allows you to control the position of a block of text in your document. You can also 
format them with borders and shading. The two commonly used methods to insert Text Boxes are 
given below: 

Method 1: 

o Select the Insert tab 

o Locate the Text group 

o Click the Text Box button 

o It displays Built-In text box menu and an option to draw table 

o With a left click select the desired text box format from the menu 

 

 

Method 2: 

o Select 'Draw Text Box' option 

o A cross shaped cursor appears 

o Left click the mouse and holding it down drag it to draw the box of desired dimensions 

 

 

 

 

 

 

**MS Word** 

 



 
 

 

 
 
1.14 Bold, Italic and Underline Commands in MS Word: 

These commands are given in the Font group in the Home tab. Their functions are given below; 

o Bold: It allows you to Bold the text of your document 

o Italic: It allows you to Italicize the text of your document 

o Underline: It allows you to underline the text of your document 
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1.15 How to Apply Style in MS Word: 

You can create professional and presentable documents in MS Word by applying different styles. 
The basic steps to apply a style in a document are listed below; 

o Select the text to which you want to apply the style 

o Select the Home tab 

o In Styles group you will see different styles; 

 
o To view more styles click the drop-down arrow 

o It displays style menu 

o Select the desired style with a left-click 
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1.16 How to Customize Style in MS Word: 

If you are looking for formatting options that are not given in the built-in styles, you can modify or 
customize an existing style to fulfill your needs. The steps to customize a style are as follows; 

 

o Select the style that you want to modify 

o Right click the mouse 

o It displays a list of different commands 

o Select the 'Modify' option; 

 
o 'Modify Style' dialogue box appears 
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o Make the desired changes to formatting 

o Click OK to apply the changes to style 

1.17 How to Create New Style in MS Word: 

You can add new styles to your list of styles, i.e. Word allows you to set the styles for font, figure, 
paragraph, etc. It helps you to keep consistency in all the documents of a topic or subject. The steps 
to create new styles are given below; 

 
Select the Home tab 
In Styles group click the arrow at the right bottom corner of the group 
It displays the 'Styles' task pane; 

 
In 'Styles' task pane click the 'New Style' button 
It displays 'Create New Style from Formatting' dialogue box; 

o Enter the name for new style and make all the desired changes 

o Click OK, the new style will be added to the list of styles 
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1.18 How to Change Page Orientation in MS Word: 

Page Orientation refers to the direction in which a document is displayed. It is of two types; 
portrait (vertical) and landscape (horizontal). The default orientation is portrait; it can be 
changed to landscape by following these steps; 

o Select the Page Layout tab 

o Locate the Page Setup group 

o In Page Setup group click the Orientation command 

o It displays two options, Portrait and Landscape 

o Select the desired page orientation 

 
 

1.19 How to Change Page Size in MS Word: 

The default paper size in Word is 8.5 x 11 inches which easily fits in printers. This size is not fixed; 
you can change it if you want a document with different paper size. The steps to change the paper 
size are given below; 
 
 
Click the Page Layout tab 
 
In Page Setup group click the Size command 
Paper size menu will appear 
With a left click select the desired paper size 
To customize page size click the 'More Paper Sizes' option 
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1.20 How to Change Page Margins in MS Word: 

The margin is the space between the text and border of a document. By default, it is a one-
inch space. Depending on your needs, it can be changed by following the below-listed steps; 

o Select the Page Layout tab 

o In Page Setup group click the Margins command 

o A list of Margins appears 

o Select the desired Margin with a left click 
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To customize Margins select 'Custom Margins'. It displays a 'Page Setup' dialog box. Enter the 
desired margin size and click Ok. 
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1.21 How to Insert Page Break in MS Word: 

Word inserts a page break at the end of each page. It also allows you to insert a page break 
at some other place in the document. The steps to insert page break are given below; 

o Place the cursor where you want to insert the break 

o Select the Page Layout tab 

o In Page Setup group click the 'Breaks' command 

o A list of Page Breaks appears 

o With a left click select the desired page break from the list 
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1.22 How to Insert Header and Footer in MS Word: 

Header and Footer allow you to add additional information like dates, file names, page 
numbers at the top or bottom of your document. The basic steps to set up a header and footer 
are given below; 

o Select the Insert tab 

o Locate the Header & Footer group 

o It shows Header and Footer commands 

o As required click either Header or Footer command 

o It displays a list of built in Header or Footer options 

o Select the desired option 
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1.23 How to Insert Table in MS Word: 

Table is a versatile tool of MS Word. It allows you to organize your information, i.e. you can 
align text, present numerical data and create forms and calendar. The steps to insert table are 
given below; 

o Place the cursor where you want to insert the table 

o Select the Insert tab 

o In Tables group click the Table command 

o It displays different options to insert the table 

o Select the desired option to insert the table 
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1.24 To Convert Text to Table: 

o Select the text 

o Select the Insert tab 

o In Tables group click the Table command 

o Select the 'Convert Text to Table' option; 
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o It displays a dialog box 

o In 'Separate text at' section select the desired option 

o Click OK, the text will convert to a table 

 
 

1.25 How to Add Row in Table: 

If you want to increase or add a new row in your table, you can follow the steps given below; 

o Place the cursor in a row above or below which you want to add row 

o Right click the mouse 

o A menu appears 

o Place the arrow over Insert option 

o It will display a menu 

o As required select 'Insert Rows Above' or 'Insert Rows Below' 
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1.26 How to Add Column in Table: 

If you want to increase or add a new column in your table, you can follow these steps; 

o Place the cursor in the column adjacent to which you want to add the column 

o Right click the mouse 

o It displays a menu 

o Place the arrow over Insert option 

o It shows a list of commands 

o As required select 'Insert Columns to the Right' or 'Insert Columns to the Left' 
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1.27 How to Delete Column or Row in Table: 

The table command also allows you to delete a column or row in your table. You can delete 
the unwanted columns or rows by following these steps; 

o Select the column or row of the table 

o Right click the mouse 

o A menu appears 

o As required select 'Delete Columns' or 'Delete Rows' 
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ENGS-101TS-3: MS Power Point 

 Identify the names and functions of the PowerPointinterface. 

 Create, edit, save, and printpresentations. 

 Formatpresentations. 

 Add a graphic to a presentation. 

 Create and manipulate simple slide shows with outlines andnotes. 

 Create slide presentations that include text, graphics, animation, andtransitions. 

 Use design layouts and templates for presentations. 

 Create a PowerPointpresentation. 

 
1. Getting Started: 

Step 1: Click the Start button. 
Step 2: Click All Programs option from the menu. 
Step 3: Search for Microsoft Office from the sub menu and click it. 
Step 4: Search for Microsoft PowerPoint from the submenu and click it. 

This will launch the Microsoft PowerPoint 2010 application and you will see the following 
presentation window at figure 1(e) 
 

 

 
                  Figure: 1(a)                            Figure: 1(b)                                  Figure: 1(c) 
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                            Figure: 1(d)                                                         Figure: 1(e) 
 

2. Power Point ─ Exploring Windows: 
The following screenshot shows the various areas in a standard PowerPoint file. It is 
important to familiarize yourself with these areas as it makes learning and using PowerPoint 
easier. 
 

 
File Tab: 
This tab opens the Backstage view which basically allows you to manage the file and settings in 
PowerPoint. You can save presentations, open existing ones and create new presentations based on 
blank or predefined templates. The other file related operations can also be executed from this 
view. 

 
The ribbon contains three components:   

 Tabs: They appear across the top of the Ribbon and contain groups of relatedcommands. 
Home, Insert, Page Layout is examples of ribbon tabs.   

 Groups: They organize related commands; each group name appears below thegroup on 
the Ribbon. For example, a group of commands related to fonts or a group of commands 
related to alignment, etc. 

 Commands: Commands appear within each group as mentioned above. 
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Title Bar: 
This is the top section of the window. It shows the name of the file followed by the name of the 
program which in this case is Microsoft PowerPoint. 

 
Slide Area: 
This is the area where the actual slide is created and edited. You can add, edit and delete text, 
images, shapes and multimedia in this section. 
 

Help: 
The Help Icon can be used to get PowerPoint related help anytime you need. Clicking on the "?" 
opens the PowerPoint Help window where you have a list of common topics to browse from. You 
can also search for specific topics from the search bar at the top.  
 

 
Zoom Options:  
The zoom control lets you zoom in for a closer look at your text. The zoom control consists of a 
slider that you can slide left or right to zoom in or out, you can click on the - and + buttons to 
increase or decrease the zoom factor. The maximum zoom supported by PowerPoint is 400% and 
the 100% is indicated by the mark in the middle. 
 

Slide Views: 
The group of four buttons located to the left of the Zoom control, near the bottom of the screen, lets 
you switch between PowerPoint views.  

 Normal Layout view: This displays page in normal view with the slide on the right and a 
list of thumbnails to the left. This view allows you to edit individual slides and also 
rearrange them.  

 Slide Sorter view: This displays all the slides as a matrix. This view only allows you to 
rearrange the slides but not edit the contents of each slide.  

 Reading View: This view is like a slideshow with access to the Windows task bar in case 
you need to switch windows. However, like the slideshow you cannot edit anything in this 
view. 
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Notes Section: 
This section allows you to add notes for the presentation. These notes will not be displayed on the 
screen during the presentation; these are just quick reference for the presenter.  
 

 
 
Quick Access Toolbar: 
The Quick Access Toolbar is located just under the ribbon. This toolbar offers a convenient place 
to group the most commonly used commands in PowerPoint. You can customize this toolbar to suit 
your needs.  
 

Slide Tab: 
This section is available only in the Normal view. It displays all the slides in sequence. You can 
add, delete and reorder slides from this section. 
 

3. PowerPoint - Backstage View 
In Office, Microsoft replaced the traditional file menu with the new Backstage view. This 
view not only offers all the menu items under the file menu, but additional details which 
makes management of your files a lot easier. 

 

Accessing Backstage View: 
You can access the Backstage view simply by clicking on the File tab. You can exit this view by 
clicking on any tab (including the File tab again). You can also press the 'Esc' button on the 
keyboard. 
 

 
 

Organization of Backstage View: 
The backstage view has three sections or panes. 
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 First Pane: This is the commands pane which consists of all the commands you would 
typically find in the file menu of older versions. You also have the Options menu which lets 
you edit the options on the program like customizing the ribbon.  

Various commands under the first pane are described in the table below: 
 

Command Description 
Save This allows you to save a new file or an existing file in standard 

format. If you are working on a previously saved file this will save 
the new changes in the same file format. If you are working on a 
new file, this command would be similar to the Save As command. 

Save As Allows you to specify the file name and the file type before saving 
the file. 

Open Allows you to open new PowerPoint files. 
Close Allows you to close an existing file. 
Info Displays the information about the current file. 
Recent Lists series of recently viewed or edited PowerPoint files. 
New Allows you to create a new file using blank or pre-defined 

templates. 
Print Allows you to select the printer settings and print the presentation. 
Save & Send Allows you to share your presentation with larger audience via 

emails, web, cloud services, etc. 
Help Provides access to PowerPoint Help. 
Options Allows you to set various options related to PowerPoint program. 
Exit Closes the presentation and exits the program. 

 
 Second Pane: This is the subcommands pane. This will list all the commands related to the 

main command you choose in the first pane. For example, if you select Print in the first 
pane, you get to choose the printer and adjust the print settings in the second pane.  

 Third Pane: This is the preview or file information page. Depending on the command and 
the subcommand you select, this pane will either display the properties of the file or give 
you a preview of the file. 
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4. Power Point ─ Creating Presentation   
PowerPoint offers a host of tools that will aid you in creating a presentation. These tools are 
organized logically into various ribbons in PowerPoint. The table below describes the various 
commands you can access from the different menus. 
 

 
 

Menu Category Ribbon Commands 
Home Clipboard functions, manipulating slides, fonts, paragraph 

settings, drawing objects and editing functions 
Insert Insert tables, pictures, images, shapes, charts, special texts, 

multimedia and symbols 
Design Slide setup, slide orientation, presentation themes and 

background 
Transitions Commands related to slide transitions 
Animations Commands related to animation within the individual slides 
Slideshow Commands related to slideshow set up and previews 
Review Proofing content, language selection, comments and comparing 

presentations 
View Commands related to presentation views, Master slides, color 

settings and window arrangements 
 
Besides these depending on the objects selected in the slide, there are other menu tabs that get 
enabled. 
 

5. PowerPoint ─ Adding New Slides 
In this chapter, we will understand how to add new slides in an existing presentation. Here 
are the steps that allow you to insert a new slide in the deck:  

Step 1: Right-click in the Navigation Pane under any existing slide and click on the New Slide 
option. 
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Step 2: The new slide is inserted. You can now change the layout of this slide to suit your design 
requirements.  

 
 
Step 3: To change the slide layout, right-click on the newly inserted slide and go to the Layout 
option where you can choose from the existing layout styles available to you. 
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You can follow the same steps to insert a new slide in between existing slides or at the end on the 
slide list. 
When we insert a new slide, it inherits the layout of its previous slide with one exception. If you are 
inserting a new slide after the first slide (Title slide), the subsequent slide will have the Title and 
Content layout.  
You will also notice that if you right-click in the first step without selecting any slide the menu 
options you get are different, although you can insert a new slide from this menu too. 
 

 
 

6. Power Point ─ Adding Text in Boxes 
PowerPoint allows users to add text to the slide in a well-defined manner to ensure the 
content is well distributed and easy to read. The procedure to add the text in a PowerPoint 
slide is always the same - just click in the text box and start typing. The text will follow the 
default formatting set for the text box, although this formatting can be changed later as 
required. What changes is the different kinds of content boxes that support text in a 
PowerPoint slide.   
Given below are some of the most common content blocks you will see in PowerPoint. 

 
Title Box: 
This is typically found on slides with the title layout and in all the slides that have a title box in 
them. This box is indicated by "Click to add title". 

 
 
Subtitle Box: 
This is found only in slides with the Title layout. This is indicated by "Click to add subtitle".  
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Content Box: 
This is found in most of the slides that have a placeholder for adding content. This is indicated by 
"Click to add text". As you can see, this box allows you to add text as well as non-text content. To 
add text to such a box, click anywhere on the box, except on one of the content icons in the center 
and start typing. 

 
 
Text Only Box: 
This is not a default content box available in PowerPoint, but you can create it using Slide Master, 
if required. This is also indicated by "Click to add text". The only difference between the Text Only 
Box and the Content Box is that the former only supports text in the content area.  
 

 
 

7. Power Point ─ Adding New Text Boxes 
This chapter will teach you how to add new text boxes in a slide. Most of the standard 
layouts come with the text box option. As mentioned in the previous chapter, text boxes 
will have "Click to add text" as the default text. Here are the steps to add new text boxes in 
slide.  

Step 1: Click on the Text Box icon in the Home ribbon under the Drawing section. 
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Step 2: You will get the insert text box cursor that looks like an inverted cross.  
Step 3: Click to insert a text box. You can now start typing directly into the text box.  
 

 
 
Step 4: Alternately, you can click and drag the cursor without releasing the click to create a text 
box. 
 

 
**MS Power Point** 

 



 
 

 

The size of the text box can be adjusted by selecting one of the edges marked by squares or corners 
marked by circles. 

 
 

8. Power Point ─ Deleting Existing Slide 
There are times while building a slide deck, you may need to delete some slides. This can 
be done easily from PowerPoint. You can delete the slides from the Normal view as well as 
the Slide Sorter view. In each view, you can delete the slides in two ways. 
 

Deleting from Normal View  
Step 1: Go to the Normal view. 

 
 
Step 2: Right-click on the slide to be deleted and select the Delete Slide option. 
 

 
Alternately, you can select the slide and press the Delete button on your key board. 

**MS Power Point** 

 



 
 

 

 
Deleting from Slide Sorter View: 
Let us now understand how to deleted slides from the Slide Sorter View. 
Step 1: Go to the Slide Sorter view. 
 

 
 
Step 2: Right-click on the slide to be deleted and select the Delete Slide option. 

 
 
Alternately, you can select the slide and press the Delete button on your key board. 
 

9. Power Point ─ Rearranging Slides 
Rearranging slides is important when it comes to organizing the overall presentation flow. 
While it is vital that you get the right content in every slide, it is equally important that you 
are able to present them in a format that makes it easier for the audience to understand the 
content too; most times this will require rearranging the slides.  
 
You can rearrange slides from two views in PowerPoint - Normal View and Slide Sorter 
View. Given below are the steps to rearrange slides from different views. 
 

Normal View: 
Step 1: Select the slide to be moved  
Step 2: Left click on the slide and drag it to the position in the sequence where you want to place 
it. PowerPoint will indicate the insert position with a line in-between existing slides. 
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Step 3: When you get to the right position release the left click button to insert the slide. 
Alternately you can also cut the selected slide and paste it back in the sequence as shown below. 

 
Slide Sorter View: 
Let us now understand how the Slide Sorter View works.  
Step 1: Select the slide to be moved.  
Step 2: Left click on the slide and drag it to the position in the sequence where you want to place 
it. PowerPoint will indicate the insert position with a line in-between existing slides. 
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Step 3: When you get to the right position, release the left click button to insert the slide  
Alternately you can also cut the selected slide and paste it back in the sequence as shown below. 
 

 
 

 
---------The End-------- 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ENGS-101TS-4: Installing Operating System and Utility Software: 

By accomplishing this part, students should be able to: 



 
 

 

 Install and run different types of operating system 

 Install and run different types of utility software. 

 

Installing Operating System 
 
Objective: 
Introducing studentshow to set up operating system in Laptops, Desktops etc. We will install 
Windows and Linux Operating System. 
 
Outcome:  
1.Will be able to set up operating system in a new or used pc. 
2. Will be able to set up Linux and Windows.  
 
 

Skill/Requirement Physical 
Appearance 

Procedure Links 

Some of Operating 
Systems 

Follow the 
instructions given in 
the link below and try 
it by yourself 
on your computer. 

Windows: 
https://www.windowscentra
l.com/how-do-clean-
installation-windows-10 

Windows 
Operating System 

Linux: 
https://www.inf.uva.es/en
/instalacion-del-sistema-
operativo-linux/ 

 
Linux Operating 
System 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Utility Software Installation- Uninstallation.  
   
   
Objective: 



 
 

 

Introducing students how to install utility software like adobe, Avro, media player etc. 
 
Outcome:  
1. Will be able to Install utility software in Computer. 
2. Will be able to Uninstall utility software from computer.   

 

Skill/Requirement Physical Appearance Procedure Links 
 
 
 
Installing Utility 
software. 

Software other than system 
software 
is called utility software. There 
are so 
many utility software. 
Installation 
process of them are almost 
same. So I 
have added an example of 
installation 
process: Please follow the link. 
 

Installation: 
https://www.co
mputerhope.co
m/iss 
ues/ch000561.h
tm 
Un-
installation: 
https://www.so
ftwarehow.com
/unins 
tall-programs-
windows/ 

 
 
 
Installing Adobe 

 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

ENGS-101 TS-5: Mailing skill: 

By accomplishing this skill, students should be able to: 

 Open email account,  



 
 

 

 Attachment file, CC, BCC, in mail. 

 Use Google Drive and YouTube Channel,  

 Convert word file to PDF, PDF to word, and usage of team viewer. 
 
Objective: 
Introducing student how to use email account and Google drive. 
 
Task:Students have to learn usage of Email and Google Drive. 
 
Outcome:  
1.Opening E-mail account. 
2. Sending and receiving email with appropriate subject and notations.  
3. Uploading file into google drive. 
4. Downloading file from google drive.  
5. Managing google drive and email. 
 
 

Skill/Requirement Physical 
Appearance 

Procedure Links 

 
Electronic Mail 

 

 
 
Email (electronic mail) is a 
way 
to send and receive 
messages across 
the Internet. Managing E-
mail please 
follow the link below. 

 

 
 
 
Google Drive 

 
 

 

E-mail: 
https://support.google
.com/a/users/ 
answer/9259846#1.4 
Google Drive: 
https://support.google
.com/drive/an 
swer/2424384?co=G
ENIE.Platform%3D
Desktop&hl=en 

   
   

 

 
 
 
 
 
 
 
ENGS-101TS-6: PC Assembling and Disassembling: 
By accomplishing this skill, students should be able to: 

 Assemble different parts of a PC like power supply, motherboard, processor, ram, storage, hdd, 
sdd, optical drive, gpu, sound card, keyboard, mouse, monitor, etc. 

 Dissemble various parts of a PC 



 
 

 

 

Objective: 
 Introduction to Computer Assembling and Dis-assembling and their uses in day to day task of a 
Computer Engineer. 
Task: 
Students will learn how to assemble and dis-assemble a computer for any kind of office using 
computer. 
Outcome:  
a. Familiarization with basic parts of a modern computer. 
 b. Knowledge about RAM, ROM etc. 
 c. Knowledge about Hard Disk. 
 d. Knowledge about Monitor.  
 e. Knowledge about PCB mother board. 
 
 

Skill/Require
ments 

Physical 
Appearance 

Working Principal 
 

Links 

 
Computer 
Monitor 

 

Modern computers become more 
affordable when users upplement 
their monetary investment with a 
few hours of effort. This 
computer build will be very 
basic and will be the minimum 
hardware necessary to have a 
functional system. After you 
have all of the parts and 
materials needed, it will take 
between 2 and 4 hours to 
assemble your computer and you 
will need to be able to use simple 
hand tools, such as a screwdriver 
and a pair of pliers. 
 
Since some of hardware is very 
sensitive so you have to be 
careful while assembling or 
dis-assembling 

https://www.instr
uctables.com/id/o 
w-To-Assemble-
A-Basic-Desktop-
PC/ 

 
RAM 

 

 
  

 
Hard Disk 

 

 

 
Mother Board 

 

 

 
Processor 

 

 

 
Safety 

measurement 
 
 

  

 

ENGS-101TS-7: Printer Set up, File sharing 

By accomplishing this part, students should be able to: 

 Set up a printer 



 
 

 

 Share file through LAN,MAN,WAN 
 

Setting Up Printer and Sharing with more than one device. 
   
Objective: 
Introducing students how to setup a printer and share with more than one device. 
Task: 
Student will learn setting up printer and be able to share it with devices. 
Outcome:  

1. Students will be able to Setting up a new printer with PC. 
2. Students will be able to Setting up wireless printer, Bluetooth printer. 
3. Students will be able to Sharing printer with devices. 

 

Skill/Requirement Physical Appearance Procedure Links 
 
 
 
Printer 
 
 
 
 
Install Local Printer 
 
 
 
 
Install Wireless 
Printer 
 
 
 
Install Bluetooth 
Printer 
 
 
 
 
 
Sharing a printer in a 
Home Group 
 
 
 

 
 

 
 

 
 

 
 
 

 

 
 
Here are the basic 
steps you'll 
follow to set up 
almost any printer.  
 

 
 
https://support.microsof
t.com/en- 
us/help/17420/windows
-printer- 
problems 

 

Presentation Week 

Presentation week will be arranged for every level. By accomplishing this part, students should be 
able to: 

 Achieve communicationskills 



 
 

 

 Enhance confidencelevel 

 Improve bodygesture 

 Develop PowerPointSkills 

 Increase EnglishFluency 

 Progress Eye Contact 



 
 

 

Assessment Process: 
 

Practical/ Demonstration 
 

Viva-Voce  

 
Step One - Practical/Demonstration 

Result criteria:Fail or Pass 

This is a very vital process of evaluation. Every student must pass this step. Otherwise he/she 

can not move the next level. Basically, in this stage, students will show practically what they 
have learnt on this level. 

EX: Suppose, students are learning English typing 25 words per minute. Now during 
evaluation, accessor will see whether students are capable to type 25 words per minute or not. 
If any student cannot be able to perform so, he or she will be marked as failure for this level. 

Evaluation Centre:Computer Lab 

Evaluation Criteria: 

i) Students have to follow the evaluation instructions given on the desktop of 

computer. Suppose, they will be instructed to write mathematical equation on 

specific task. Moreover, they are asked for showing the typing capability following 

the given paragraph. 

ii) Students must perform every instruction given on the assessment time. If any 

student is not able to perform any single particular task, then she or he will be 

disqualified for the evaluation process. The judgment benchmark will be 0 or 100. 

It means failed or passed. 

iii) For the assessment process, there will be more than two assessors in where one 

must be in external for keeping the transparency on the evaluationprocess. 

 

Step Two – Viva-Voce 

Evaluation Criteria: 

i) What skills will be learned from students within one level is the syllabus of the 

Viva- voce. By executing this step, students will be examined that whether the 

skills they learnt is in satisfactory level ornot. 

ii) Assessor including internal as well as external will ask minimum 10 questionrelated 
to the level one topic. Students have to give answer orally about 80% of the given 
portion of questions. Below 80% performance will not be acceptable. He or she will 
be treated as failure 



 
 

 

 
 
 

 
 
 
 
 
 
 

Part-B 

Communicative Skill (CS) 

 

 

 

 

 

 

 

 
 

 
 
 



 
 

 

ENGS-101 CS-1: Greetings (The art of greetings in English, necessary for 

communicating with people.) 

English Greetings for Professional/Formal Situations: 

There are many situations in which we may need more formal or business professional language 

in English. Some common examples include: 

 Business meetings & negotiations (e¨emvwqK wgwUs Gi ‡¶‡Î)  

 At a job interview (PvKzwii B›UviwfD Gi †ÿ‡Î)  

 Communicating with high-level management (D”P c`¯Í e¨w³e‡M©i mv‡_ K_‡cvK_b) Saying 

hello to the company president or CEO (‡Kv¤úvwbi e‡mi mv‡_ mvÿv‡Z)  

 Showing respect to elderly individuals or people we do not know well (e‡qv‡Rô‡`i m¤§vb 

Rvbv‡bvi †ÿ‡Î) 

 Meeting new business colleagues (bZzb e¨emvwqK m½xi mv‡_ wgwUsG)  

 Communicating with new clients, high-level clients, angry clients (K¬vB›U Gi mv‡_ K_‡cvK_b)  

Good morning / Good afternoon / Good Evening 

Good morning, everyone. I hope you are doing well this morning. 

Hello. How do you do? 

This is not really a “How are you?” question. It is really a simple greeting and has a similar 

meaning to “Nice to meet you.” 

Nice to meet you. / pleased to meet you. 

A: “Good morning. How do you do? I’m Josef Rammas with X Company.” 

B: “Pleased to meet you Mr. Rammas.” 

How have you been doing? / How have you been? 

It is a respectful way to ask “How have you been?” with someone you have not seen in a long 

time or someone you do not see every day. 

 

English Greetings for Informal Situations: 

Example situations include: 

 In the office with your team and colleagues (Awd‡m KwjM‡`i mv‡_)   

 Meeting or a lunch with a regular client (K¬vBbU Gi mv‡_ ỳcy‡ii Lvev‡ii mgq A_ev wgwUs G)  

 Networking events (‡bUIqvwK©s B‡f‡›U)  



 
 

 

 Trade show or job fair (PvKixi B‡f›U G)  

 Conferences (Kbdv‡iÝ G)  

 Greeting neighbors (cÖwZ‡ekxi mv‡_ AvjvcPvwiZvq)  

Hello / Hi / Hey 

Lara: Hello, Susan. 

Susan: Hi, Lara. 

How are you? / How are you doing? / How is it going? 

Lara: Fine, thanks. and you? 

Susan :Great! you? 

Lara :Hi, Susan – good thanks. How about you? 

Susan :Doing well. And how have you been? 

Lara :Not bad. And you? How are you? 

Susan :Hello, Lara. How are you?* 

Good to see you. / It’s great to see you. / Nice to see you. 

Lara: Hello, Susan. It’s good to see you! 

Susan :well, it was great to see you. I have to get going. Have a good day. Goodbye. 

 

Long-time, no see. / It’s been awhile. / When was the last time we saw each other? 

How have you been? / How have things been going (since I last saw you)? / What have you 

been up to? 

A: “Long-time, no see” or “It’s been awhile.” 

B: Great thanks. Did you hear we are moving to California next month? 

A: Doing well. We’ve just returned from our summer vacation. And how about you? 

B: Nothing to complain about! The family is good and work is fine. Just the same old, same 

old. What about you? 

 

 

 

 

 



 
 

 

ENGS-101 CS-2: How to Ask for, Grant and Refuse Permission (The art of 

ask, grant or refuse permission in English, necessary for communicating with 

people.) 

 

How to Ask for Permission in English 

Can I + verb (very informal) 

Can I go out tonight? 

Can he have dinner with us? 

May I + verb 

May I have another piece of pie? 

May we go out with our friends tonight? 

Could I please + verb 

Could I please go with Tom to the movie? 

Could we please go on trip this weekend? 

Do you think I could + verb 

Do you think I could use your cell phone? 

Do you think I could borrow your car? 

Would it be possible for me + infinitive 

Would it be possible for me to use your computer for a few minutes? 

Would it be possible for to study in this room? 

Would you mind if I + verb in past 

Would you mind if I stayed a few more minutes? 

Would you mind if I took a five minute break? 

Would you mind my + verb + ing + your + object 

Would you mind my using your cellphone? 

Would you mind my playing your piano? 

How to Grant Permission in English 

 Sure. 

 No problem. 

 Go right ahead. 

 Please feel free + infinitive 



 
 

 

How to Politely Refuse a Favor/Deny Permission 

 I'm afraid I'd prefer if you didn't / don't. (Avwg `ytwÿZ, Avwg PvB‡ev hvZ Zzwg GUv bv K‡iv)  

 Sorry, but I'd rather you not do that. (`ytwÿZ, GUv bv Ki‡jB fvj)  

 Unfortunately, I need to say no. (`ytwÿZ †h Avgv‡K bv ej‡Z n‡PQ)  

 I'm afraid that's not possible. (`ytwÿZ, GUv m¤¢e bq) 

 I'm afraid I can't let you borrow my car, but I could drive you instead. (`ytwÿZ Avwg †Zvgv‡K 

Avgvi MvwowU avi w`‡Z cviwQ bv, wKš‘ †Zvgv‡K †cŠ‡Q w`‡q Avm‡Z cvwi) 

 I wish I could help out; maybe another time. (Bk, Avwg hw` †Zvgv‡K mnvqZv Ki‡Z cviZvg, nq‡Zv 

ev Ab¨ †Kvb GK mgq)  

  



 
 

 

ENGS-101 CS-3: Basic Writing (Basic writing skill in English for the 

elementary level learners.) 

 

Topics to write about with an example  

Farmer 

Bangladesh is an agricultural country. Most of the people live in villages and are farmers. They 

grow cereals, pulses, vegetables and fruits. The farmers lead a tough life. They get up early in the 

morning and go to the fields. They stay and work on the farm late till evening. The farmers 

usually live in huts. Though, they work hard they remain poor. Farmers eat simple food; wear 

simple clothes and rear animals like cows, buffaloes and oxen. Without them there would be no 

cereals for us to eat. They play an important role in the growth and economy of a country. 

Abyev` t evsjv‡`k GKwU K…wl cÖavb †`k| AwaKvsk †jvK MÖv‡g emevm K‡i Ges Zviv K…lK| Zviv km¨, Wvj, kvK-mewR 

Ges dj Pvl K‡ib| K…lK‡`i Rxeb Lye KwVb| Zviv †fvi †ejv Nyg †_‡K D‡V gv‡V hvb Ges mÜ¨v Aewa KvR Ki‡Z 

_v‡Kb| K…l‡Kiv mvaviYZ Kzu‡o N‡i emevm K‡i| K‡Vvi cwikÖg Kiv ¯‡̂Ë¡I Zv‡`i Afve †g‡Ubv| K…l‡Kiv mvaviY Lvevi 

Lvq, mvaviY †cvkvK cwiavb K‡i Ges wewfbœ ai‡Yi cÖvwY, †hgb Miæ, gwnl Ges luvo, jvjb-cvjb K‡i _v‡K| Zv‡`i Qvov 

Avgiv †Kv‡bv Lv`¨ km¨ †cZvg bv| †`‡ki mg„w× Ges A_©bxwZ‡Z Zviv ¸iæZ¡c~Y© f‚wgKv cvjb K‡ib| 

 

Hawker 

A hawker is a person who moves from one place to another and sell their goods, by shouting on 

the streets. They work hard throughout the day. They move on the street on their bicycle and 

sometimes on foot and sell their products. We can see hawkers everywhere. They move 

everywhere selling their goods without caring about the weather. There is a hawker who sells 

vegetables on his bicycle in our locality. His name is Monir. He brings fresh vegetables at a very 

reasonable price. He is a nice and an honest hawker. 

 

 



 
 

 

Abyev` t †dwiIqvjv Ggb GKRb e¨w³ whwb GK RvqMv †_‡K Av‡iK RvqMvq hvb Ges iv Í̄vq †W‡K †W‡K Zvi wRwbmcÎ 

wewµ K‡ib| wZwb mvivw`b K‡Vvi cwikÖg K‡ib| wZwb KL‡bv mvB‡K‡j K‡i Avevi KL‡bv cv‡q †nu‡U hvZvqvZ K‡ib Ges 

Zvi wRwbmcÎ wewµ K‡ib| Avgiv †dwiIqvjv‡`i me RvqMvq †`L‡Z cvB| AvenvIqvi †Zvqv°v bv K‡i Zviv meRvqMvq 

Ny‡i Ny‡i Zv‡`i wRwbmcÎ wewµ K‡ib| Avgv‡`i GjvKvq GKRb †dwiIqvjv Av‡Qb| whwb Zvi mvB‡K‡j K‡i kvK-mewj 

wewµ K‡ib| Zvi bvg gwbi| wZwb b¨vh¨ g~‡j¨  kvK-mewR wewµ K‡ib| wZwb GKRb fv‡jv Ges mr †dwiIqvjv| 

 

Doctor 

The doctor is a person who looks after the sick people and prescribes medicines so that the 

patient recovers fast. In order to become a doctor, a person has to study medicine. Doctors lead a 

hard life. Their life is very busy. They get up early in the morning and go to the hospital. They 

work without taking a break. They always remain polite so that patients feel comfortable with 

them. Since doctors work so hard we must realize their value. 

Abyev` t wPwKrmK Ggb GKRb e¨w³ whwb Amy ’̄ †jvK‡`i ZË¡veavb K‡ib Ges Zv‡`i Ilyac‡Îi wb‡ ©̀k bv †`b hv‡Z K‡i 

Zviv `ªæZ my ’̄ n‡q I‡V| wPwKrmK nIqvi Rb¨ GKRb e¨w³‡K †gwWwmb wel‡q Aa¨qb Ki‡Z nq| wPwKr‡Kiv e¨ Í̄ Rxeb 

hvcb K‡ib| Zviv mKvj †ejv Nyg †_‡K I‡Vb Ges nvmcvZv‡j P‡j hvb| Zviv weiwZnxbfv‡e KvR K‡i _v‡Kb| 

wPwKrm‡Kiv me mgqB †ivMx‡`i mv‡_ gvwR©Z AvPiY K‡ib hv‡Z K‡i Zviv ¯^v”Q›`¨‡eva K‡i| wPwKrm‡Kiv †h‡nZz K‡Vvi 

cwikÖg K‡ib, †m‡nZz Avgv‡`i DwPZ Zv‡`i g~j¨ Dcjwä Kiv| 

Street Beggar 

A street beggar can be seen everywhere; at the bus stop, railway stations, religious places, 

markets etc. Some beggars are crippled, lame and some are blind. They are unable to earn their 

livelihood. Whereas some of them are healthy and they do not deserve our sympathy. We should 

see that they take up some profession. They should not be allowed to beg. On my way to school I 

see a beggar daily. He wears old rags. He is partially blind. I feel pity seeing him but I can’t help 

it I can only pray to God to help him to earn his livelihood. 

 

 



 
 

 

Abyev` t GKRb wfÿzK‡K cÖvq me RvqMvq †`L‡Z cvIqv hvq, evm÷‡c, †ij‡÷k‡b, agx©q ’̄v‡b, evRv‡i Ges AviI 

A‡bK RvqMvq| wKQz wKQz wfÿzK weKjv½ Avevi wKQz wKQz wfÿzK AÜ| Zviv Zv‡`i RxweKv wbe©vn Ki‡Z Aÿg| Zv‡`i 

g‡a¨ †KD †KD Avevi my ’̄̈  Ges Zviv Avgv‡`i mnvbyf‚wZi †hvM¨ bq| Avgv‡`i DwPZ Zv‡`i Rb¨ Kv‡Ri e¨e ’̄v K‡i †`qv| 

Zv‡`i wfÿv Ki‡Z †`qv DwPZ bq| cÖwZw`b ¯‹z‡j hvIqvi c‡_ Avwg GKRb wfÿzK‡K †`L‡Z cvB| wZwb cy‡iv‡bv †Quov 

vKco c‡I _v‡Kb| wZwb AvswkK AÜ| Zv‡K †`‡L Avgvi `qv nq wKš‘ Avwg Zv‡K mvnvh¨ Ki‡Z cvwi bv| Avwg ïay ¯ªóvi 

Kv‡Q cÖv_©Yv Rvbv‡Z cvwi hv‡Z K‡i †m wb‡Ri RxweKv wbe©vn Ki‡Z cv‡i|  

Solar System 

The Solar System consists of the Sun Moon and Planets. It also consists of comets, meteoroids 

and asteroids. The Sun is the largest member of the Solar System. In order of distance from the 

Sun, the planets are Mercury, Venus, Earth, Mars, Jupiter, Saturn, Uranus, Neptune and Pluto; 

the dwarf planet. The Sun is at the center of the Solar System and the planets, asteroids, comets 

and meteoroids revolve around it. 

Abyev` t m~h©, P› ª̀ Ges Ab¨vb¨ MÖn wb‡q †mŠi RMZ MwVZ| GLv‡b ayg‡KZz Ges MÖnvYy we`¨gvb| †mŠi RM‡Zi me‡P‡q eo 

m`m¨ m~h©| m~h© †_‡K `~i‡Z¡i µg Abymv‡i MÖn ¸‡jv nj eya, ïµ, c„w_ex, g½j, e„n¯úwZ, kwb, BD‡ibvm, †bcPzb Ges cøy‡Uv 

(†hwU Avm‡j GKwU evgb MÖn)| ‡mŠi RM‡Zi †K‡› ª̀ i‡q‡Q m~h©  Ges Ab¨vb¨ MÖn, MÖnvby Ges ayg‡KZz G‡K †K› ª̀ K‡i 

cwiågb Ki‡Q| 

Moon 

The Moon is a barren, rocky world without air and water. It has dark lava plain on its surface. 

The Moon is filled with craters. It has no light of its own. It gets its light from the Sun. The Moo 

keeps changing its shape as it moves round the Earth. It spins on its axis in 27.3 days stars were 

named after the Edwin Aldrin were the first ones to set their foot on the Moon on 21 July 1969 

They reached the Moon in their space craft named Apollo II. 

Abyev` t Puv` GKwU Abye©I, cv_y‡i MÖn †hLv‡b evqy Ges cvwb Abycw ’̄Z| GwU c„w_exi GKgvÎ DcMÖnb| Gi mgZj c„ô 

†`k Kv‡jv jvfvi ˆZwi| P› ª̀ c„ô AmsL¨ M‡Z© cwic~Y©| Gi wbR¯̂ †Kv‡bv Av‡jv †bB| GwU m~h© †_‡K Av‡jv cvq| c„w_exi 

Pvi w`‡K †Nvivi mv‡_ mv‡_ Puv` Gi wb‡Ri AvK…wZ cwieZ©b Ki‡Z _v‡K| wbj Avg©ós Ges evR AjwWªb 1969 mv‡ji 21 

†k RyjvB me© cÖ_g Puv‡`I ey‡K cv iv‡Lb| A¨v‡cv‡jv 11 bv‡gi GKwU gnvKvk hv‡b K‡i Zviv `uv‡` †cŠu‡Q wQ‡jb| 



 
 

 

Stars 

The stars are tiny points of light in the space. On a clear night we can see around 2,000 to 3,000 

stars without using a telescope. Stars look tiny in the sky because they are far away from the 

Earth. In ancient times the sky watchers found patterns of stars in the sky.These astronauts Neil 

Armstrong and patterns of people and the creatures from the myths and the legends. As the Earth 

spins from east to west the stars also appear to cross from east to west. The stars are made up of 

gases. 

 

Abyev` t Zviv (bÿÎ) n‡jv gnvKv‡k Aew ’̄Z ÿz`ª ÿz`ª Av‡jvK we› ỳ| iv‡Zi †ejv cwi®‹vi AvKv‡k Avgiv `~iexÿY hš¿ 

QvovB cÖvq 2000 †_‡K 3000 Zviv †`L‡Z cvB| c„w_ex †_‡K †ek `~‡i nIqvq Zviv‡`i Lye †QvU †`Lvq| cÖvPxbKv‡j 

AvKvk ch©‡eÿKiv AvKv‡k Zviv‡`I bKkv Lyu‡R †c‡qwQ‡jb Ges Zviv †cŠivwYK wewfbœ wKse`wšÍ Ges cÖvwYi bKkv Lyu‡R 

†c‡qwQ‡jb| c„w_ex †h‡nZz Gi wbR A‡ÿ cwðg †_‡K c~e©w`‡K AveZ©b K‡i, Zviv‡`iI †`L‡j g‡b nq Giv cwðg †_‡K 

c~e©w`‡K AwZµg Ki‡Q| Zviv¸‡jv M¨v‡mi ˆZwi AwZ Kvqej| 

 

 

 

 

 

 

 

 

 

 

 

 



 
 

 

ENGS-101 CS-4: Basic Vocabulary (Basic vocabulary for the Bengali learners.) 

Part-1 
 

Awry = AuvKv-euvKv 
Abject = †kvPbxq Ae¯’v 
Abash = j¾v †`Iqv 
Abscond = cvwj‡q _vKv 
Aberration = wec_Mgb 
Acidulous = nvjKv U‡Kv 
Actuate = cÖfvweZ Kiv 
Addendum = AwZwi³ ms‡hvRb 
Adroit = `ÿ 
Adorn = mvRv‡bv / my›`i Kiv 
Agape = gyL nv K‡i Av‡Q Ggb 
Agility = `ÿZv 
Allure = cÖ‡jvwfZ Kiv 
Amorphous = AvKvinxb 
Ample = cÖPzi / ch©vß 
Amass = Rgv Kiv / cywÄfzZ Kiv 
Antipathy = weivM / Zxeª N„Yv 

 
Part-2 

 
Antithesis = mivmwi wecixZ KvR 
Analgesic = †e`bvbvkK 
Anathema = Awfkvc 
Anodyne = ‡e`bvbvkK Jla 
Appliance  = hš¿cvwZ 
Ardor  = Av‡e‡Mi ZxeªZv 
Appellation  = bvg / †LZve 
Aperture  = wQ‡`ª 
Append  = †k‡l hy³ Kiv 
Apposite  = mwVK / h‡_vchy³ 
Appurtenance  = Abylw½K wRwbm 
Apparition  = fzZ / Ac”Qvqv 
Apprehend  = ‡MÖdZvi Kiv 
Aquatic  = Rjxq 
Aquiline  = euvKv‡bv 
Articulate  = ¯úófv‡e D”PviY Kiv 
Ascendancy  = ÿgZv / cÖvavb¨ / cÖwZcwË 
Assimilate  = †kvlY K‡I †bIqv 
Apostate  = ¯^ag©Z¨vMx / ag©Z¨vMx 

 



 
 

 

Part-3 
 

Archaic - Archeology = cÖZœZË¡/cyivZb ev cÖvPxb 
Artifice-Artificial = bKjKvR 
Artifice = A_© a~Z©Zv ev PvjvK 
Artisan = KvwiMi 
Artist  = wkíx / KvwiMi 
Asunder  = ci®úi wew”Qbœ nIqv 
Assurance  = wbðqZv / cÖwZkÖæwZ / A½xKvi 
Asteroid  = DcMÖn 
Attrition  = ax‡i ax‡i ÿq ev n«vm 
Atone  = cÖvqwðË Kiv ev ÿwZc~iY Kiv 
Atrocity = ee©i KvR 
Atrophy  = ÿ‡q hvIqv 
Awkward  = †egvbvb / wekÖx 
Avarice  = A_© wjáv / †jvfx 
Anomaly  = Awbqg / wek„•Ljv 
Anguish  = Zxeª hš¿Yv 
Babble  = Av‡evj Zv‡evj eKv 
Bestow  = cyi®‹vi cÖ`vb 
Behemoth  = wekvjvKvi cÖvYx / Rjn Í̄x 
Bovine  = †evKv / wb‡e©va 
Blowhard  = evPvj 
Burgeon  = `ªæZ †e‡o IVv 
Baroque  = AwZwi³ mw¾Z 
Barefaced  = gy‡Lvknxb / Abve„Z 
Ban  = wbwl× 
Bane  = me©bvk / `~NUbvi †nZz / wel 

 
 
 

Part 4 
 

Bilk = duvwK †`Iqv / cÖZviYv Kiv 
Bevy = eo `j 
Bedraggle = m¤ú~Y©iƒ‡c wf‡R hvIqv 
Belie = wg_¨v aviYv †`Iqv 
Baritone = cyiælKÉ wewkó ¯̂i 
Bereaved = `ytwLZ, ewÂZ, †kvKv”Qbœ, wew”Qbœ 
Beset = AZ¨vPvi Kiv, mgm¨vµvšÍ nIqv 
Boorish = Abyf‚wZnxb 
Beatitude = ¯^M©myL, cig myL, Pig myL 
Blemish  = †`vl, ÎæwU, Kj¼, LyuZ 



 
 

 

Bravado = mvn‡mi mv‡_ KvR Kiv ev mnm cÖ`k©Y Kiv 
Burnish = N‡l PKP‡K Kiv ev cwi®‹vi Kiv 
Bulwark = KwVb cÖvPxi 
Baffle = e¨_© nIqv 
Belabor = DËg ga¨g †`Iqv, cÖnvi Kiv, gviv 
Baleful = fq cÖ`k©YKvix 
Belittle = †QvÆ Kiv 
Belated = wej¤^/‡`wi 
Camaraderie = mnKgx©‡`i gv‡S mngwg©Zv I ci®ú‡ii cÖwZ Av ’̄v 
Candor = ¯úóevw`Zv 

 
 

Part 5 
 

Comestible = Lvevi Dc‡hvMx `ªe¨ 
Calamity = Pig wech©q / `ytL ỳ`©kv 
Cavalier = wkóvPvi ewR©Z 
Collaborate = GK‡Î KvR Kiv 
Commonplace = MZvbyMwZK 
Complement = cwic~Y© Kiv 
Complacent = AvZ¥Z…ß 
Colossus = wekvj cÖwZg~wZ© 
Concave = MZ©hy³ / AeZj 
Cohorts = mk ¿̄ ˆmb¨`j 
Curtail = Kgv‡bv/n«vm Kiv 
Compress = msKzwPZ Kiv 
Conception = avibvi m~ÎcvZ 
Condone = Gwo‡q Pjv 
Consign = AvbyôvwbKfv‡e n¯ÍvšÍi Kiv 
Concession = Aby‡gv`b 
Compute = MbYv Kiv / wnmve Kiv 
Cajole = cÖZviYv Kiv / wgwó K_vq gb †fvjv‡bv 
Correlation = cvi®úvwiK m¤úK© 

 
Part 6 

 
Cow = fq cÖ`k©Y Kiv 
Connivance = m¤§wZ Av`vq Kiv 
Choleric = wLU wL‡U / e` †gRvwR 
Centripetal = †K‡›`ªi w`‡K AwfgyL 
Continuum = GKUvbv 
Clarify = e¨vL¨v Kiv 
Crass = AgvwR©Z 



 
 

 

Credence = wek¦vm/Av ’̄v 
Calligraphy = my›`i †jLv 
Careen = AvuKv-euvKv / wZh©K 
Comatose = Ae‡PZb/wb ª̀vgMœ 
Contraband = A‰ea e¨emv 
Concise = mswÿß 
Cacophonous = kÖæwZKUz 
Deviate = c_åó nIqv 
Defrock = AcmviY Kiv 
Dichotomy = `yB fv‡M wef³ 
Debris = aŸ©m¯‘c 
Deliberate = Mfxifv‡e wPšÍv Kiv 
Dogma = AÜwek¦vm 
Duplicity = KcUZv/Qjbv 
Dolor = gb Lvivc 
Dismantle = wew”Qbœ Kiv / P‚Y© Kiv 

 
 
 

Part 7 
 

Deplore = Aby‡kvPbv Kiv 
Dilettante = †Kv‡bv e¨vcv‡i Ag‡bv‡hvMx 
Debacle = m¤ú~Y© cZb, aŸsm 
Despondent = gbgiv, nZvkvMÖ¯’v 
Dormant = NygšÍ/Ajm/Amvo 
Diminutive = †QvU 
Dire = fqven/fxlY 
Dowdy = †bvsiv, Acwi”Qbœ 
Dishearten = wbiærmvn Kiv 
Diva = MxwZbv‡U¨i MvwqKv 
Dispatch = `ªæZZv/`ªæZ m¤úv`b 
Disdain = N„Yv/ Zvw”Q‡bœ¨i †Pv‡L †`Lv 
Distrait = Ag‡bv‡hvMx 
Disparity = AmgZv/ZviZg¨/cÖ‡f` 
Dyspeptic = e`nRg 
Disclaim = `vwe Z¨vM Kiv 
Debonair = cÖdzjø / †Lvk‡gRvwR 
Deadlock = APj Ae¯’v m„wó Kiv/wbðjZv 
Dote = fvjevmvq AÜv nIqv 

 
 
 
 



 
 

 

Part 8 
 

Decelerate = MvZ n«vm Kiv 
Dulcet = mygayi 
Embargo = wb‡la Kiv 
Effrontery = gy‡L gy‡L ZK© Kiv 
Endearment = ‡¯œn/Av`i/fvjevmv 
Effeminate = †g‡qwj ˆewkóc~Y© 
Exemplify = D`vniY mnKv‡i e¨vL¨v Kiv 
Estrangement = we‡”Q` 
Elated = AwZkq Avbw›`Z/cig DjøvwmZ 
Eerie = inm¨RbK/AvZ¼RbK 
Elite = AwfRvZ 
Entomology = cZ½weÁvb 
Ecologist = cwi‡e‡ki mv‡_ cÖvYxi m¤úK© wel‡q we‡klÁ 
Effete = `ye©j / Aÿg / RxY© 
Elucidate = wek`fv‡e e¨vL¨v Kiv / ¯úó Kiv 
Emanate = wbM©Z nIqv 
Empathy = mnvbyf‚wZ  
Enormous = cÖPzi 
Enlighten = Ávb `vb Kiv 
Emotive = Av‡eMZvwoZ 
Encroach = mxgv jsNb Kiv 
Economize = e¨q ms‡KvP Kiv 
Enamored = †cÖggy»/ †cÖg Avm³ 

 
Part 09 

 
Endanger = Drcv`b Kiv / cÖme Kiv 
Elusory = QjbvKvix 
Exalt = cÖksmv Kiv 
Exposition = e¨vL¨v KiY 
Exigency = Ryiæwi Ae¯’v 
Extenuate = n«vm Kiv / cÖkwgZ Kiv 
Engage = A½xKvi Kiv 
Entreat = AvšÍwiKZvi mv‡_ PvIqv 
Empirical = AwfÁZvjä 
Elation = AZ¨vwaK myL / Avb‡›`i Abyf‚wZ 
Entrée = cÖ‡ek / cÖ‡ekc_ 
Encomium = cÖksmv 
Ennui = wei³ 
Eclectic = evQvBK…Z 
Egoism = AnwgKv / AvZ¥ev` 



 
 

 

Encompass = †NivI Kiv 
Exculpate = †`vl †`qv 
Emaciate = cvZjv I `ye©j 
Embellish = mw¾Z Kiv / mvRvb / Aj¼…Z Kiv 
Facsimile = AweKj cÖwZiƒc / Abywjwc 
Engaging = AvKl©K / g‡bvig 
Fiscal = A_© msµvšÍ/UvKv-cqmv/ab-m¤ú` m¤úwK©Z 
Fallacy = fzj / wg_¨v wek¦vm 

 
Part 10 

 
Fervent = Mig / Zß 
Forsake = Z¨vM Kiv 
Frigid = kxZj / wb®úÖvY 
Fraudulent = cÖZviYvc~Y© 
Flora = Dw™¢`K‚j / Dw™¢` m¤ú` 
Finesse = ‡KŠk‡ji `ÿZv 
Fracas = ˆn ‰P / nÆ‡Mvj 
Feasible = hv ev¯Í‡e cwiYZ Kiv hvq 
Flamboyant = RvKuv‡bv / eY©vX¨ 
Figurine = ÿz`ªvK…wZ 
Fulsome = AwZwi³ 
Forge = AwMœKzÛ 
Gibberish = `ªæZ D”PvwiZ / euvPvj 
Gainsay = A¯̂xKvi Kiv 
Gait = nvUvi aiY / Pjb fw½ 
Gambit = †h †Kv‡bv cÖv_wgK c`‡ÿc 
Gastronomy = myLv`¨ / †fvRb we`¨v 
Glamorous = †gvnbxq / AvKl©Yxq 
Genre = bxwZ / aviv / cÖKvi 
Ghastly = fqvbK / weivUKvi 

 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

 

ENGS-101 CS-5: Translation (Everyday use sentences which is required for 

communicating in English.) 

 

01. Present Tense 
1.1 Present Simple Tense 

A. I rise early in the morning. (Avwg mKvj †ejv Nyg †_‡K DwV) 

B. He is a scientist. (wZwb GKRb weÁvbx)  

C. The sun sets in the west. (m~h© cwð‡g A¯Í hvq)  

D. She does not like to dance. (wZwb bvP‡Z cQ›` K‡ib bv)  

E. Does he want a cup of tea? (wZwb wK GK Kvc Pv Pvb?)  

1.2 Present Continuous Tense 
A. I am going to school. (Avwg ¯‹z‡j hvw”Q)  

B. They are playing football. (‡Zviv dzUej †Lj‡Qv) 

C. He is not running to and fro. (‡m Gw`K-Iw`K †`Šov‡”Q bv)  

D. It is not raining now. (GLb e„wó n‡”Q bv)  

E. Are you talking over phone? (Zzwg wK †dv‡b K_v ej‡Qv)  

1.3 Present Perfect Tense 
A. He has done the work. (‡m KvRwU K‡i‡Q)  

B. They have eaten mangoes. (Zviv Avg¸‡jv †L‡q‡Q)  

C. He has reached England. (‡m Bsj¨v‡Û †cuŠ‡Q‡Q)  

D. Tipu has not worked hard. (wUcy K‡Vvi cwikÖg K‡iwb)  

E. Have you ever gone to Cox's Bazar? (Zzwg wK KL‡bv K·evRvi wM‡q‡Qv)  

1.4 Present Perfect Continuous Tense 
A. I have been walking for two hours. (Avwg `yÕNÈv hver nuvUwQ)  

B. He has been working in this office for five years. (‡m GB Awd‡m cuvP eQi hver KvR Ki‡Q) 

C. She has been suffering from fever since Tuesday. (‡m g½jevi †_‡K R¡‡i fzM‡Q)  

D. It has not been raining for five days. (cuvP w`b a‡i e„wó n‡”Q bv)  

E. Have you been watching videos on YouTube since morning? (Zzwg wK mKvj †ejv †_‡K BDwUD‡e 

wfwWI †`LQ?)  

 



 
 

 

02. Past Tense 
2.1 Past Simple Tense 

A. I went to the market. (Avwg evRv‡i wM‡qwQjvg)  

B. He ate rice. (‡m fvZ †L‡jv)  

C. He was a scientist. (wZwb GKRb weÁvbx wQ‡jb)  

D. Soyeb did not buy the books. (‡mv‡qe eB¸‡jv †K‡b wb)  

E. Did you go to university yesterday? (Zzwg wK MZKvj wek¦we`¨vj‡q wM‡qwQ‡j)  

2.2 Past Continuous Tense 
A. He was reading the book. (‡m eBwU cowQ‡jv)  

B. They were playing football. (Zviv dzUej †LjwQ‡jv)  

C. We were playing hide and seek. (Avgiv jy‡KvPzwi †LjwQjvg)  

D. She was not singing a song. (‡m Mvb MvBwQ‡jv bv)  

E. Were the students making a noise in the classroom? (QvÎ/QvÎxiv wK †kÖYx K‡ÿ †Mjvgvj KiwQj?) 

2.3 Past Perfect Tense 
A. I had reached there before he came. (‡m Avmvi Av‡MB Avwg †mLv‡b †cuv‡QwQjvg)  

B. He came home after I had gone to school. (Avwg ¯‹z‡j hvIqvi ci †m evmvq G‡mwQj)  

C. The train had left before I reached. (Avwg †cuŠQv‡bvi c~‡e©B †UªbwU †Q‡o w`‡qwQ‡jv)  

D. Mother shut the door after I had got into the bed. (Avwg weQvbvq †kvqvi cig v `iRvUv eÜ K‡iwQ‡jb)  

E. They had reached the station before the bell rang. (NÈv covi c~‡e© Zviv †÷k‡b †cŠuQv‡jv)  

 

we‡kl `ªóe¨ t Bs‡iwR fvlvq Past Perfect Tense-Gi Negative Form Ges Interrogative Form K`vwPr e¨eüZ nq| Gi 

cwie‡Z© mvaviYZ Past Simple Tense- Gi Negative Form Ges Interrogative Form e¨eüZ nq| 

 

2.4 Past Perfect Continuous Tense 
A. I had been reading a letter before you called. (Zzwg Kj Kivi c~‡e© Avwg GKwU wPwV cowQjvg) 

B. She had been watching the Television when I came to meet her. (Avwg hLb Zvi mv‡_ †`Lv Ki‡Z 

Avmjvg ZLb †m †Uwjwfkb †`LwQ‡jv)  

C. We had been gossiping before the bell rang. (NÈv covi c~‡e© Avgiv Mí¸Re KiwQjvg)  

D. I had been eating rice when he came. (‡m hLb Avmj ZLb Avwg fvZ Lvw”Qjvg)  

 
we‡kl `ªóe¨ t Bs‡iwR fvlvq eZ©gv‡b Past Perfect Continuous-Gi e¨envi †bB ej‡jB P‡j|  

 
 
 
 



 
 

 

03. Future Tense 
3.1 Future Simple Tense 

A. I shall go to the varsity. (Avwg wek¦we`¨vj‡q hv‡ev)  

B. She will sing the song. (‡m MvbwU MvB‡e)  

C. Arif will help you. (Avwid †Zvgv‡K mvnvh¨ Ki‡e)  

D. They will not go shopping. (Zviv †KbvKvUv Ki‡Z hv‡e bv)  

E. Shall we wait for Shaon? (Avgiv wKkvI‡bi Rb¨ A‡cÿv Ki‡ev?)  

 

we‡kl `ªóe¨ t hw`I eZ©gv‡b shall ev will e¨env‡ii †ÿ‡Î euvav aiv †Kv‡bv wbqg †bB, Z‡e g‡bi fve †Rviv‡jvfv‡e cÖKvk Kivi 

Rb¨ shall e¨envi Kiv DËg|  

 

3.2 Future Continuous Tense 
A. Shuvra will be studying. (ïåv cov‡kvbv Ki‡Z _vK‡e)  

B. You will be doing the work. (Zzwg KvRwU Ki‡Z _vK‡e)  

C. They will be shopping. (Zviv †KbvKvUv Ki‡Z _vK‡e)  

D. We will be watching "Avengers: Endgame". (Avgiv A¨v‡fÄvm©: GÛ †MBg †`L‡Z _vK‡ev)  

E. Will she be waiting for us? (wZwb wK Avgv‡`I Rb¨ A‡cÿv Ki‡Z _vK‡eb?)  

3.3 Future Perfect Tense 
A. I will have written the poem. (Avwg KweZvwU wj‡L _vK‡ev)  

B. By the time you reach, we will have started our journey. (Zzwg G‡m †cŠu‡Qv‡Z †cuŠ‡Qv‡Z Avgiv 

Avgv‡`i hvÎv ïiæ K‡I †dj‡ev)  

C. He will have helped you. (‡m †Zvgv‡K mvnvh¨ K‡i _vK‡e)  

D. I shall have finished reading the book by 4 PM. (Avwg we‡Kj PviUvi g‡a¨ eBwU c‡o _vK‡ev)  

E. Will Shuvo have done the work by the next week? (ïf wK AvMvgx mßv‡ni g‡a¨ KvRwU K‡i ivL‡e)  

3.4 Future Perfect Continuous Tense 
A. I will have been doing the work until you return. (Zzwg wd‡I bv Avmv ch©šÍ Avwg KvRwU Ki‡Z _vK‡ev) 

B. The students will have been doing the class until the bell rings. (NÈv bv evRv ch©šÍ QvÎiv K¬vm 

Ki‡Z _vK‡e)  

C. We shall have been waiting for you until you come back. (Zzwg wd‡I bv Avmv ch©šÍ Avgiv †Zvgvi 

Rb¨ A‡cÿv Ki‡Z _vK‡ev)  

D. Arin will have been studying at University of Global Village for four years before she 

gets the degree. (Awib wWwMÖ cvIqvi c~‡e© Pvi eQi BDwbfvwm©wU Ae †Møvevj wf‡j‡R co‡Z _vK‡e) 

 

we‡kl `ªóe¨ t eZ©gv‡b Bs‡iRx fvlvq Future Perfect Continuous Gi e¨envi †bB ej‡jB P‡j|  

 

 
 



 
 

 

ENGS-101 CS-6: Dialogue (Practice dialogue sessions for a better 

communicative competence understanding.) 

 

Dialogue 1-1: Formal Greetings  

JAMES: Good morning, Professor Austin, how are you doing?  

PROFESSOR AUSTIN: Good morning, James. I am doing well. And you? 

JAMES: I’m great, thank you. This is my friend Emma. She is thinking about applying to this 

college. She has a few questions. Would you mind telling us about the process, please? 

PROFESSOR AUSTIN: Hello, Emma! It’s a pleasure to meet you. I’m more than happy to 

speak with you. Please stop by my office next week.  

EMMA: It’s a pleasure to meet you, professor. Thank you so much for helping us. 

PROFESSOR AUSTIN: Don’t mention it. Hopefully, I will be able to answer your questions! 

 

Dialogue 1-2: Informal Greetings and Farewells 

JANE: Hi, Helen! How’s it going?  

HELEN: Fine, thanks — and you?  

JANE: Just fine. Where are you off to?  

HELEN: To the library. I’ve got a history exam next week and need to start studying. Ugh. 

JANE: Oh, no. Well, I’ll see you later then. Good luck!  

HELEN: Thanks. See you later. 

 

Dialogue 1-3: Formal Introductions 

MARGARET: Mr. Wilson, I’d like you to meet Dr. Edward Smith.  

MR. WILSON: It’s nice to meet you, Dr. Smith.  

DR. SMITH: Pleasure to meet you, too.  

MARGARET: Dr. Smith is an economist. He just finished writing a book on international trade.  

MR. WILSON: Oh? That’s my field, too. I work for the United Nations.  

DR. SMITH: In the Development Program, by any chance?  



 
 

 

MR. WILSON: Yes. How did you guess?  

DR. SMITH: I’ve read your articles on technical assistance. They’re excellent. 

 

Dialogue 1-4: Informal Introductions 

JIM: Who’s the tall woman next to Barbara?  

CHARLES: That’s her friend Mary. Didn’t you meet her at Steve’s party?  

JIM: No, I wasn’t at Steve’s party.  

CHARLES: Oh! Then let me introduce you to her now. Mary, this is my friend Jim.  

MARY: Hi, Jim. Nice to meet you. 

JIM: You, too. Would you like a drink?  

MARY: Sure, let’s go get one 

 

Dialogue 1.5: What Time Is It? 

NATASHA: What time is it? We’re going to be late! 

TONY: It’s a quarter after seven. We’re on time. Don’t panic. 

NATASHA: But I thought we had to be at the restaurant by 7:30 for the surprise party. We’ll 

never make it there with all this evening traffic. 

TONY: Sure we will. Rush hour is almost over. Anyway, the party starts at 8:00. But I do need 

help with directions. Can you call the restaurant and ask them where we park our car? 

 

Dialogue 1-6: A Telephone Call 

JOHN: Hi, Alice, it’s John. How are you?  

ALICE: Oh, hi, John! I was just thinking about you.  

JOHN: That’s nice. I was wondering if you’d like to go to a movie tonight.  

ALICE: Sure, I’d love to! What’s playing?  

JOHN: I was thinking about that new comedy Lights Out. What do you think?  

ALICE: Sounds great!  

JOHN: OK, I’ll pick you up around 7:30. The movie starts at 8:00.  

ALICE: See you then. Bye! 



 
 

 

 

 

Dialogue 1-7: Can You Say That Again? 

LUKE: Hello? Hi, Stephanie, how are things at the office?  

STEPHANIE: Hi, Luke! How are you? Can you please stop and pick up extra paper for the 
computer printer?  

LUKE: What did you say? Can you repeat that, please? Did you say to pick up ink for the 
printer? Sorry, the phone is cutting out.  

STEPHANIE: Can you hear me now? No, I need more computer paper. Listen, I’ll text you 
exactly what I need. Thanks, Luke. Talk to you later.  

LUKE: Thanks, Stephanie. Sorry, my phone has really bad reception here. 

 

 

Dialogue 1-8: Coincidences 

MEG: Well, hello there, Julia! Long time no see!  

JULIA: Meg! Hi! What a coincidence! I haven’t seen you in ages! What are you doing here? 
MEG: I just got a new job in the city, so I’m shopping for some clothes. Hey, what do you think 
of this shirt?  

JULIA: Hmmm … well, you know how much I love blue. See? I’ve got the same shirt! MEG: 
You always did have good taste! What a small world. 

 

 

Dialogue 1-9: Weather Report 

JENNIFER: It’s freezing outside! What happened to the weather report? I thought this cold 
frontwas supposed to pass. 

GABRIELA: Yeah, I thought so too. That’s what I read online this morning. 

JENNIFER: I guess the wind chill is really driving down the temperature. 

GABRIELA: Can we go inside? I feel like my toes are starting to go numb. 

 

 

 

 

 

 

 

 



 
 

 

ENGS-101 CS-7: Listening (Practice listening sessions for a better 

communicative competence understanding) 

 

 What is active listening? 
Whether you're in a group or speaking with someone one-on-one, the best way 
to process verbal communication is to listen actively. 
This simply involves being able to repeat back to someone what they've told 
you, in your own words. 
You don't have to agree with what they've said; you're just proving that 
you understand what they've said. 

 How do I become an active listener? 
Active listening is a habit--once you've gained the skill, you'll utilize it without 
even knowing it! That said, it takes a lot of practice to become an effective 
active listener. 

 

What do I need to work on to become an active 
listener? 
There are 5 basic elements to active listening: 

1. Pay attention  
2. Prove you are listening  
3. Ask questions (if you need to)  
4. Don't be judgmental  
5. Respond 
 

 
Students can visit these website to improve their listening skill: 

1.https://www.youtube.com/watch?v=tBvw05SiUuQ 
2. https://www.wiziq.com/tutorials/ielts-listening 

 

*** Students may practise in listening from the videos contained in 
attached CD. 

 

*** 

 
 

 
 


